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ABSTRACT

Environmental sampling is the key method of the IAEA in searching signatures of a covert nuclear
programme. However, it is not always easy to know the exact location of the sampling site. The
satellite navigation system, utilizing a small receiver (GPS) and a PC, allows to have independent
positioning data easily. The present task on the Finnish Support Programme was launched to create
software to merge information about sampling and positioning. The system is built above a desktop
mapping software package. However, the result of the development goes beyond the initial goal: the
software can be used to real-time positioning in a mobile unit utilizing maps that can be purchased
or produced by the user. In addition, the system can be easily enlarged to visualize data in real time
from mobile environmental monitors, such as a Geiger counter, a pressurized ionisation chamber or
a gamma-ray spectrometer.
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PREFACE

Satellite navigation has been used for in-field applications by the Finnish Centre for Radiation and
Nuclear Safety since 1993. Because of this experience, training in the use of GPS positioning and
desktop mapping was chosen as a task under the Finnish Support programme to IAEA safeguards. A
lecture and a field experiment were held on a training course on environmental monitoring at the
IAEA headquarters in June 1995. The contents of the task were published by Kansanaho et. ai "GPS
positioning and desktop mapping" STUK-YTO-TR 88, Helsinki 1995. From this document the
general information about desktop mapping and GPS positioning is transferred to the present
publication. The description of the software is updated and new elements, such as production of
maps, are added.
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1 INTRODUCTION

Satellite navigation is a simple method to deter-
mine current position anywhere in the world.
When the satellite navigator data are displayed
using a computerised mapping system, anyone
can easily spot the location exactly.

A suitable map of the area of interest is the key
of successful navigation. During the last couple
of years, the production of digital maps has in-
creased and now it is possible to purchase these
maps for many applications. An advanced user

of a mapping software can also handle the pro-
duction of digital maps, starting from high-qual-
ity printed maps.

A satellite navigation system, known as SAHTI,
produced by STUK for real-time navigation and
environmental measurements. It includes a GPS-
receiver and a laptop computer, equipped with
tailored software above a commercial mapping
package. The software is produced using Visual
Basic 3.0 Professional and MapBasic 3.0.

24 satellites

Users Control station

Figure 1. GPS system.
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2 GPS-SATELLITE NAVIGATION

The Global Positioning System (GPS) is a satel-
lite navigation system designed, built and con-
trolled by the US Department of Defence. The
GPS system is based on 24 satellites which cir-
cle the earth at an altitude of 20,000 km. These
satellites are controlled by the Ground Control
Segment of the system. It's main tasks are to cal-
culate new parameters of the satellite orbits and
to correct the satellite clocks. The exact time is
essential for the whole system, since the posi-
tioning is based on measurement of time delays
in signals from satellites down to earth. A suc-
cessful navigation requires that the receiver can
"see" at least 3 satellites. However, a position,
which is calculated from signals of 4 or more
satellites gives higher accuracy.

To utilize the GPS system, the user needs a GPS
receiver, which picks up the satellite signals and
calculates current position. The accuracy of 100
metres (95 % probability) is available for all us-
ers (C/A code, civil code), whereas the US mili-
tary can reach an accuracy of 10 metres (P code,
military code). Accuracy of C/A code is usually
enough for navigation and environmental moni-
toring. For special purposes higher accuracy can
be achieved locally by utilizing differential cor-
rection techniques. In some countries, e.g. in Fin-
land and Sweden, a radio-transmitted differen-
tial correction signal is available, and thus an
accuracy of 2 m is possible even in real-time ap-
plications.

GPS receivers are of different sizes, from a
PCMCIA card up to briefcase-size models. The
smaller instruments are less precise, but still use-
able for navigation and for visualisation of envi-
ronmental monitoring data. GPS receivers return
the current position in longitude-latitude co-or-
dinates based on WGS-84 datum (World Geo-
detic System). In most GPS-receivers position
data can be passed into a computer using a serial
interface. SAHTI system supports two receivers,
Trimble SV-6 and Trimble Mobile GPS
(PCMCIA).

The Trimble Mobile GPS is using a protocol
known as TSIP (Trimble Standard Interface Pro-
tocol) in communications. The data are sent in
binary packets. Thus it is not readable without
knowing the data structure exactly. The byte or-
der for a floating point number in Visual Basic is
reversed. Therefore the values of co-ordinates and
time (expressed as single precision floating point
numbers) are calculated using IEEE 745 stand-
ard for floating point arithmetic's.

The receiver SV-6 uses a protocol know as TAIP
(Trimble ASCII interface protocol) in communi-
cations. The data are sent from the receiver as
ASCII characters. As default the receiver sends
position data every 5 seconds.
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3 DESKTOP MAPPING

3.1 Maplnfo for Windows

Desktop mapping software is a powerful tool for
presenting data of geographical significance.
Data points are displayed on a digital map with
exact location. In addition to normal data analy-
sis, Desktop Mapping offers geographical analy-
sis (measuring distances, areas etc.). It is possi-
ble for the user to spot and display the location
on earth correctly from the position data of the
satellite navigator. This, however, requires that a
high quality digital map is used as a base map.

A desktop mapping software, known as Maplnfo
for Windows, was selected for the SAHTI sys-
tem. Maplnfo is not capable of navigation by
itself. However, Maplnfo is fully programmable
through the MapBasic-language. This enables the
user to produce customised applications utiliz-
ing all Maplnfo's functions.

3.2 Base maps and co-ordinate
systems

Maplnfo for Windows can handle both major
types of digital maps, vector maps and Raster
images. Vector maps consist of individual objects,
like lines, regions etc. Vector maps are stored on
disk in special Maplnfo format. Raster Images
are standard picture files (TIFF, BMP, GIF etc.).
Both types of maps are commercially available.
The best way to find them is to ask the local Na-
tional Survey Board for advice. The commercial
suppliers for digital maps can also help to find
Maplnfo compatible maps.

Once a plane map is created, a mathematical
model, known as projection (Transferse Mercator,
Lambert etc.), is used to transform the locations

of features on the earth's surface to locations on
a two-dimensional map surface. A co-ordinate
system is created by specifying the parameters
for the projection used. One of the parameters is
known as datum (WGS-84, ED-50, ED-79). It
defines which ellipsoid is used as well as the lo-
cation of the origin. An ellipsoid estimates the
shape of the globe. When a digital map is being
selected for a base map, the co-ordinate system
of the original map has to be found.

Co-ordinates returned from GPS will not show
the correct position on the map if the co-ordinate
system of the map is not based on WGS-84 (the
difference may be hundreds of metres). There are
mathematical conversion formulas defined to
transform co-ordinates from one system into an-
other (accuracy of a few mm). However, these
formulas include usually very complicated math-
ematical functions. Since the accuracy of GPS is
only 100 m, a more simple method for co-ordi-
nate correction should be used. SAHTI system
can only perform mathematical corrections be-
tween Finnish co-ordinate systems. Therefore, in
global use the correction must be performed in
another way (see later).

3.2.1 Vector map as a base map

Vector maps are usually produced from printed
paper maps using a special digitizing table.
Maplnfo handles vector maps as database tables
where one column in a data record refers to a
geographical object (poly line, region, symbol
etc.), that corresponds to a real feature on the
earth's surface. A data record can therefore con-
tain information about the object (inhabitants of
the town, number of houses etc.). Vector maps
are especially useful when large areas are viewed.
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They can also be re-sized on the screen without
any limits. However, inaccuracies and "shortcuts"
in digitizing become disturbing when the map is
zoomed down to the finest details.

A wide range of vector maps is commercially
available. The accuracy of these maps depends
on the material they have been produced from
and on the person who has performed the digi-
tizing. The price of these maps depends on the
accuracy of the map. Maplnfo allows the user to
change the co-ordinate system of a vector map.
Disk space and memory of the PC determine the
level of details on a map, since every detail is a
single drawn object. Maplnfo can show several
vector map layers simultaneously and also in-
clude or exclude layers when a map screen is re-
sized.

The user can also define his own co-ordinate sys-
tems for Maplnfo. This, however, requires a good
knowledge of Maplnfo and co-ordinate systems.
If vector maps are used for GPS-navigation, sup-
pliers should be asked to provide their maps with
WGS-84 system. See Figure 2a) for an example
of a vector map.

3.2.2 Raster image as a base map

Raster images are mainly scanned images of
printed maps. They are ideal base maps if the

area of interest is fairly small in diameter (< 10
km). All the details in a printed map are included
in the Raster image. If a colour scanner is used,
true colours of the printed map can be applied,
too. Raster images are used only as backdrops
onto which transparent vector layers are super-
imposed.

Because the Raster image consists of small dots,
re-sizing is limited both ways by the resolution
of the image. The co-ordinate system, in which
the original material is created, cannot be changed
either. If a Raster image is based on a system
other than WGS-84, a co-ordinate correction may
have to be performed to display the co-ordinates
from GPS at the right position in ihe map win-
dow. A simple correction is presented in section
5.3.

A SPOT satellite image and an aerial photograph
are other Raster images, which are potentially
useful for safeguards purposes. SPOT satellite
images are supplied with the requested co-ordi-
nate system and they are already in digital form.
Aerial photographs do not have any built-in co-
ordinate system. Using these as base maps re-
quires either GPS-measurements on the spot or
some reference map where the co-ordinates of
the corresponding objects are found. Figure 2 b)
is an example of a Raster image.

10
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Figure 2. An example of a) a vectormap and b) of a Raster image. The top view has a scale which is 3.7
times larger than the bottom one.

11
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4 PRODUCTION OF MAPS FOR MAPINFO
Maplnfo uses two types of base maps, vector maps and Raster images. Vector maps
are usually produced from printed paper maos using a special digitising table.
Raster images are usually scanned images of printed maps. Both types of maps are
commercially available. But if they are not available of the area of interest, the
user must produce own maps from the paper copies that are available.

4.1 Using scanned images as base
maps

If no digital map is available of the area of inter-
est, Maplnfo allows the user to produce own
material. Using a scanner is the easiest way is to
create a Raster image of a paper map. Maplnfo
supports several formats for a Raster image; TIFF,
GIF, JPEG and PCX. One of these should be
available in any scanner software. Fixing the
Raster image into exact position is performed by
selecting at least three control points and giving
their exact position for Maplnfo. The procedure
depends on the original material. Three most
common cases are studied below; detailed ex-
amples are found in the appendices.

4.1.1 A map with co-ordinate system
supported by Maplnfo

In this case the paper map contains all informa-
tion needed. The parameters that make the co-
ordinate system vary depending on the projec-
tion used. Once the co-ordinate system of a map
is found, the user should refer to Maplnfo Refer-
ence manual to find out which parameters must
be given for the projection in question.

At least three points must be picked for Maplnfo
as control points in Raster image registration. The
co-ordinates of these control points in the co-or-
dinate system used are needed. If the co-ordi-
nate system is notWGS-84, some correction must
be performed for exact positioning. See Chapter
5.3 for determining the correction. An example
of fixing a map of Finland in the Finnish co-or-
dinate system is given in Appendix 3.

4.1.2 A map where the scale and origin
longitude are known, but other co-
ordinate system parameters are
unknown

Most of the plane paper maps are created in
Transfer Mercator projection (also known as
Gauss-Gruger). Any Transfer Mercator projected
map can be fixed correctly, if the origin longi-
tude and map scale are known.

The origin longitude is a parameter, which gives
the central meridian for the map projection. The
Central meridian (for example 27.00000oE) is
running parallel with map's Y-axis. Usually the
information of the central meridian is printed, but
if not, the map has to be studied carefully or the
supplier must be contacted.

Maplnfo must be set to use the same central me-
ridian in Transfer Mercator projection as found
in the original map. The user may have to define
a new co-ordinate system. The control points are
measured carefully so that they stand on a map
forming a rectangular with sides running paral-
lel to the map axis. The distances from one care-
fully chosen control point, the main point, are
measured with a ruler and converted into metres
using the scale factor of the map. The location of
the main point is eventually located exactly us-
ing GPS. The co-ordinates in metres are then cal-
culated for other control points and the map can
be exactly positioned. A detailed example of fix-
ing a Raster map of Tallinn area is given in Ap-
pendix 3.

12
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4.1.3 A map where the scale and co-
ordinate system are unknown

Sometimes the only map of the area is a tourist
map or a large scale atlas map. Fixing of these
maps exactly is impossible. Maplnfo enables,
however, the user to point the locations of se-
lected control points in a map window. At first,
some spots in the environment, which correspond
to certain objects on a printed map, must be se-
lected and positioned using SAHTI. Suitable
spots are bridges, road junctions, field corners
etc.. SAHTI creates a new map layer with a sym-
bol corresponding to one of the chosen spots in
the nature. The number of the spots should be
from 10 to 15 and they should be spread out
over the whole map area. When all the spots are
recorded and added on the map layer, fixing of
the Raster image is performed by pointing each
control point in the Raster image with corre-
sponding symbol on the measured map layer. An
example is given in Appendix 3.

4.2 Production of own vector
maps

If only Raster maps of the area of interest are
available, Maplnfo allows the users to produce
vector maps of their own. The maps are digitized
with Maplnfo drawing tools (Poly line, symbols
etc.). Digitizing is usually performed from a
Raster base map with drawing tools. For digitiz-
ing roads, the Poly line drawing tool is selected.
The roads then are followed on the screen by the
mouse. The corners are marked by clicking the
mouse. A building can be placed on the map by
using the Symbol tool. After all the objects wanted
are placed on the map, the layer is saved as a
map. An example is given in Appendix 4.

13
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5 SAHTI SATELLITE NAVIGATION
SYSTEM

SAHTI system is built by the aerosol laboratory of the Finnish Centre for Radiation and
Nuclear Safety (STUK). Radiation measurement results and GPS co-ordinates have been
combined in the laboratory since 1993. These applications were based on retrospective
desktop mapping. Following the same ideas, a real-time navigation system, SAHTI, was
developed for in-field measurements. The same approach is now applied to safeguards
purposes under the Finnish support programme to IAEA. The system consists of a GPS-
receiver (Trimble, Mobile GPS or SV-6) and a laptop computer. The software is produced
using Visual Basic and MapBasic programming languages.

5.1 Overview of SAHTI software

The main body of the system, the SAHTI con-
trol panel, performs co-ordinate acquisition,
stores time and co-ordinates into a file and passes
the information to the mapping application. This
program is known as SAHTI.exe. A MapBasic

program, known as SAHTI.mbx, runs within
Maplnfo and displays the position on a selected
base map. Some display settings can also be per-
formed in SAHTI.mbx program. A third part of
the system is known as IMPORT.exe, which han-
dles the viewing of previous measurements. Fig-
ure 3 shows the layout of the whole system.

GPS

PC-computer

GPS

MS-Windows
SAHTI.exe

IMPORT.exe
Maplnfo

SAHTI.mbx

Figure 3. SAHTI system, version 1.1.

14
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5.1.1 SAHTI control panel

The program is produced with Visual Basic. It
communicates with a GPS-receiver through a
serial interface. Position, time and status of the
receiver are displayed in the SAHTI window. The
navigator is configured automatically by
SAHTI.exe to send the positioning data once
every second. Position data are received through
a serial interface with the speed of 9600 bps (Mo-
bile GPS) or of 4800 bps (SV-6). Mobile GPS
sends information of health of the receiver every
20 seconds, whereas SV-6 sends the same infor-
mation every second.

SAHTI system can be configured through Basic
Setup in Options menu. Changes are performed
by typing alternative values in the textboxes.

Some parameters cannot be changed in Basic
Setup window. These parameters are changed by
editing the GPS.INI-file in Windows directory.
A copy of the file must also be in the Maplnfo
directory for SAHTI.mbx. Figure 4 shows the
layout of SAHTI.exe.

In Basic Setup window the user can define de-
fault parameters which are used in SAHTI sys-
tem:
MAP DIR shows the Maplnfo's directory.
MBX FILE shows, which MapBasic program is

used.
DEFAULT DATA FILE shows the directory and

the name of the file where the data is
saved.

DEFAULT FILE ID shows the first 4 characters
of the positioning file name.

Selept Basemap

Figure 4. SAHTI.exe. Selecting an item in the "Options" menu shows new windows in which the system
can be modified (Basic Setup, Edit map list). Selecting item "Maplnfo" confirms the use of Maplnfo in
the system and it starts automatically when positioning is started by clicking the "Start "-button. Every
time the co-ordinates are updated, information is passed to SAHTI.mbx, using Windows DDE-link. De-
tailed status for GPS positioning can be viewed by clicking the "GPS"-button.

15
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COMM. PORT defines which serial port is
being used.

COMM. PROTOCOL defines the protocol used
(TSIP/TAIP).

PLOT INTERVAL defines the interval how
often the map is updated (seconds).

USE DEFAULT WOR FILE defines if the
default Maplnfo workspace is used when
positioning is started.

DEFAULT worfile is the name of the default
Maplnfo workspace.

MAPINFO ON START defines if Maplnfo is
started together with the positioning.

CORRECTION defines which correction mode
is used.

DRAW MODE defines if cumulative or single
spot drawing is used.

If the value of a field is changed, SAHTI system
checks validation of the new value. If the new
value is not valid, a message is displayed and the
old value is returned. Changes can either be saved
to be permanent or to be used just in the present
session. When SAHTI is started the system reads
the settings from the GPS.INI file and uses them
as default.

The co-ordinates and time are saved to an ASCII
file defined by the user. The names of the direc-
tory and the file are given in the Basic Setup win-
dow. The file name consist of four user defined
characters and date in DDMM format
(STUK2106.WGS). The extension WGS stands
for WGS-84 system co-ordinates. The file name
can also be changed in the GPS Control panel
window. The file contains information about the
source (PCMCIA/DGPS), date, time, longitude,
latitude, speed, satellite identification numbers
and altitude. The file is saved to the directory
defined in Basic Setup. Detailed file format and
description for the data fields are given in Ap-
pendix 5.

Selecting "GPS"- button shows the GPS control
panel. A more detailed status of the GPS receiver
is shown. If any errors occur while trying to get
the positioning data, it's shown on this window.
The following changes or selections can be made:
(1) positioning start or stop, (2) name of the
ASCII file for the positioning data and (3) fre-
quency (interval) for data saving.

The following information is received from the
GPS navigator (see Figure 5):
Time is the time received from the GPS.

SAHTI system changes also the time of
the PC accordingly.

Latitude and longitude are degrees in WGS-84
system.

Speed shows speed in km/h.
Mode shows the GPS system mode. Mode

refers to two-dimensional or three-
dimensional positions. A 2-D position fix
provides latitude and longitude. Altitude is
assumed to be fixed. Only three satellites
are required to provide 2-D position. A 3-
D position provides the altitude in addi-
tion to latitude and longitude and requires
four satellites.

Satel nr. field shows the identification numbers
of the useable satellites.

Satellites field tells the status of the GPS
receiver.

Status adds a mark ("n") on status field every
time it receives data from GPS.

PDOP field tells the accuracy of positioning.
PDOP (Position Dilution of Precision) is a fig-
ure of merit expressing the relationship between
the error in user position and the error in satellite
position. Values considered good for positioning
are small. Values larger than 7 are considered
poor. If PDOP is too high, an error message is
shown in Satellites field and no positions can be
received from GPS.

GPS (PCMCIA)

<S)GPS

Time:
Latitude :
Longitude :
Spaed:
Mode :
Snlel.nr:
Satellites:
Status:
PDOP:

O Differential GPS
00:09:24
GO.20314
25.05493
4.7 km/h
GPS2D
24.27.19.0
Doing position fixes

4.1

(x Positioning file

Interval (s):

iaeu22501.wgs

Start

Stop

Cancel

Figure 5. GPS control panel. The GPS receiver sta-
tus is seen during the positioning. "H" mark is added
to the status field every time the system gets data
from the GPS receiver. Positioning can be started
and stopped from the panel.
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5.1.2 GPS application for Maplnfo,
SAHTLmbx

SAHTI.mbx is a MapBasic application that dis-
plays the position as a symbol in the right posi-
tion. A drop-down menu, "GPS", is added in
Maplnfo's menu bar when SAHTI.mbx is
executed. Figure 6 shows the layout of
SAHTI.mbx.

Edit Symbol brings out a Maplnfo's symbol
picker dialogue where the drawing style of the
position symbol can be changed.

Corrections opens a dialogue where the desired
correction method can be selected. Finnish cor-
rection is a simple mathematical correction from
WGS-84 to the national co-ordinate system, KKJ.
Free correction moves the symbol by the given
amount of metres. Positive values move the sym-
bol towards East (Lon) and North (Lat). When
None is selected no correction is performed.

Draw mode sets the display either in cumulative
or non-cumulative mode. The text on the win-
dow shows the current mode when the dialogue
window is loaded.

C Ftnnith conaclion

T Fieo Un P

<• None

Lai I

^ £ *

Sompiini) location

Sample ID.

Eompto lypo

TftNm nmmbet*

Desaipbon

(mtu SUQ char)

Gamptioq conditions'

TompotRtvm.

Bel »lumidHy {%)

pH

Conrfudtvity (mS)
Photograph f
f i lm*

Cm mnnsuiHm«nl

Save marked points Into an ASCII (Ilo

i b H ^ ' ' c \ i n e V '^i<;^i ^ Frfn '• ••'•; '••"•;l' y. 1 •

;LlMFitftSn13VpP::::V:'^:- ^ A : ^ ^ to'*®*
| luxlhtu r-b>0 Ti] ,;;|iäi;i.l.l»blll S] >

Figure 6. A layout of SAHTLmbx. A drop-down menu appears in Maplnfo when SAHTI.mbx is executing.
Several functions are performed by selecting an item in the drop-down-menu.
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Mark positions ables to mark the locations with
special interest. Information is recorded and
saved. Draw mode must be non-cumulative. The
procedure is repeated until all desired points are
marked. Mark shows a dialogue for entering in-
formation of the point and updates the table
"FixPoint" with the information for location of
interest. Save Table opens a dialogue for saving
the marked locations as a Maplnfo table. Save
ASCII opens a dialogue for saving the marked
locations as an ASCII file.

If the draw mode is changed into cumulative
mode while positions are being marked, the ta-
ble "FixPoint" is saved and closed. The table is
saved in user defined directory with the name
"FIXPOINT.TAB". It is recommended to save the
marked positions with the name defined by the
user before the draw mode is changed.

Import previous opens navigating sessions and
displays them. This option executes program
IMPORT.exe. The map is automatically updated.

5.1.3 Previous data viewer, IMPORT.exe

IMPORT.exe program executes automatically
when "Show previous" is selected in Maplnfo's
"GPS" menu.

An ASCII file is opened for reading through a
standard Windows File Open dialogue. The co-
ordinate correction which is used for a certain
map is applied when old data is imported. A new
Maplnfo table, named by the user, is opened and
the data are automatically updated in Maplnfo's
map window. Figure 7 shows the layout of
IMPORT.exe.

Open coordinate file

File: c:

2605_ap.wgs

Iinja2.wgs

\nks\linja1

MM m

.wgs

c:\

332HH

3c: [ELITE •

" . " • - • • . ! •

•Cancel U

File spec.: ;:i [c:\nks\linja1.wgs

Save previous measurements as Maplnfo Table

File Name:

prev

Directories:
c:\map3

OK

List Files of Type:

CD data
CD hesa
CD mb_code
C3 sahti
CD trados
CDtyk

Drives:

Cancel

Network...

Table (\tab) c: elite 510

Figure 7. Layout ofIMPORT.exe. Data are read from an ASCII file with standardformat. Symbols of the
old measurements are automatically added in the current Map window and a new table, named by the
user, is opened.
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5.2 Starting positioning

Before starting the system, the user should en-
sure that there are digital maps available of the
area of interest. Digital maps can also be pro-
duced from paper maps by using a digital scan-
ner and Maplnfo.

Once the maps have been purchased or produced,
a Maplnfo workspace for navigation must be pre-
pared. A workspace is a set of map layers, which
are displayed in the way the user wants. Prepara-
tion of Maplnfo workspace is presented in Ap-
pendix 1.

Before starting the navigation, it should be
checked that the antenna can see enough open
sky (not too many buildings or trees around).
Because of signal attenuation, the accuracy of
positioning might be lower or the receiver might
not get signals from the satellites at all.

When the program has been started, it may take
some 3 to 8 minutes before the co-ordinates ap-
pear on the screen. The system works in real time
when the navigator has found three useable sat-
ellites for calculation of the first position. The
co-ordinates are updated in the SAHTI window
with the interval selected by the user. The title of
the window shows the status of the navigator.
There is a label with caption "HEALTH", appear-
ing and disappearing on the bottom of the SAHTI
window, showing that the communication is
working. When a sufficient number of satellites
is noticed by the GPS-receiver, the label on the
bottom of the window reads "OK" and the status
of the navigator changes to "Doing Position
Fixes". If Maplnfo is used, a symbol appears in
the map window, showing the current position
every time the co-ordinates are updated. All the
co-ordinates are stored in a file, defined by the
user. The file name consists of four characters
given by the user, the date with four characters
and an extension (e.g. IAEA1906.WGS). When
the position symbol moves away from the area
shown in the current map window, the view is
automatically updated so that the last position

symbol is shown in the middle of the map win-
dow. Navigation is finished by quitting "GPS"-
menu in Maplnfo and selecting "Exit" in SAHTI
program. Step-by-step instruction of using
SAHTI system is presented in Appendix 2.

5.3 Confirming the position on
the map

If the base map is used for the first time, the user
should confirm that the position obtained from
the GPS-receiver corresponds to the location
found on the base map. This is especially impor-
tant if the co-ordinate system is not based on
WGS-84, or has not been completely defined.
Confirmation is performed by letting SAHTI sys-
tem to run in one spot for a long time with the
plot interval of 10 seconds. The "Draw mode"
must be set in cumulative mode (setting in
Maplnfo, GPS menu). After about an hour, the
centroid of all measured positions is estimated
and the distance between the measured centroid
and the location on the map is measured using
Maplnfo's ruler tool. The centroid corresponds
to the real location in the nature with an accu-
racy of 30 metres or better.

If the centroid of all measurements is less than
50 m away from the corresponding position on
the map (measured with Maplnfo's ruler tool),
the map fits in its correct position well enough
and no correction is needed. If the centroid is
clearly further away from corresponding position
on the base map, a correction must be performed.

There are some simple methods to perform the
correction. The easiest method is a linear correc-
tion, where the symbol is forced by a certain
number of metres towards the right direction. In
Maplnfo's GPS menu there is a submenu for cor-
rections. Linear correction of given number of
metres is performed by selecting "Free correc-
tion" and typing the distances into the text boxes
beside. The same correction parameters are ap-
plicable over 100 km away from the spot on
which the correction was defined. The same lin-
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ear correction parameters should be used every
time when the map is used. Therefore the cor-
rection should be carefully recorded, "Finnish
correction", in the corrections window, is a local
correction applied only in Finland with the Finn-
ish base maps.

Especially for Raster images, there is another
method. Once one spot has been determined with
GPS reliably (long time acquisition), the distance
between the position according to GPS and the
correct position on the map is measured with
Maplnfo (with the ruler tool). Raster Image Reg-
istration in Maplnfo is changed to bring the map
object at the same position with the measured
one. This is performed by adding (or subtract-
ing) the differences into X andY co-ordinates of
Raster Image control points, respectively. The
advantage in moving the whole map is that it only
has to be performed once. There is no need to
remember any correction parameters either.

5.3 Information for
environmental sampling

SAHTI system provides a tool for book-keeping
of information in sample collection. Locations
of special interest can be marked and saved in
either ASCII or Maplnfo table format.

The draw mode must be non-cumulative. Mark
is selected from GPS-menu and a sample col-
lecting dialogue appears. After filling the fields
and pressing OK, a red spot appears on the map
and a new table "FixPoint" is opened.

After marking all the wanted points, the table can
be saved as an ASCII file or Maplnfo table. The
ASCII file has "," as a field separator (Excel file).
This function can also be used for fixing a Raster
image with unknown scale and co-ordinate sys-
tem. Figure 8 shows the layout of the Sample
collecting dialogue.

S T , ' Mark positions . , I

Longitude

Latitude

Time

Sampling location

Sample ID

Sample type

Team members

Description

(max 200 char.)

Sampling conditions

Temperature

Rel. humidity (%)

pH

Conductivity (mS)

Photograph #

Fi lm*

Analytical request

Mark

1
?.h.iih3M |

i

I

13:(M:15

STUK

2

CAR

TIL JKR

Car measurements

+15

Cancel

Figure 8. Sample collecting dialogue. The fields can be filled while marking the spot or they can be edited
afterwards. After marking the spot a browser window appears in Maplnfo with the sample collecting
data.
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PREPARATION OF A MAPINFO WORKSPACE

MAPINFO WORKSPACE

APPENDIX 1

Maplnfo's workspace is a selection of maps in one or more map windows. Names of maps and
display settings (colour, region fill style, etc.) are stored into a file with an extension ".WOR". You
can include in your workspace several map layers (vector and Raster). It is recommended that the
bottom layer in the map window is a large vector map, e.g. map of World or Europe. The preparation
includes the following steps:

1. Make sure that all the maps you want to include are stored on the hard disk of your computer.

2. Start MapInfo.

3. Select Open a Table in File menu. Through the dialogue which appears, open a map which you
want to include in your workspace (largest map first, e.g. map of world). Repeat until all desired
maps are opened.

- File > Open Table

]pad_liet.tab

2605_ap.tab
hexa.tab
jätealue.tab
karlalue.tab
pad_joet.tab

adjät.tab

svomod3.tab

File Format:

Open Table

tHiectories:
c:\nkx

I

Diives:

Open

Cancel

[Maplnfo \±j

jx Display table in window

: elite 510
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APPENDIX 1 PREPARATION OF A MAPINFO WORKSPACE

4. If any vector layers are included, you can change the display style.

- Map > Layer control > Display > Display mode

Layer Control

Lover

Cosmetic Layei
Ind Value with Luokka

PAD JAR
PADJOET

Visible Editable
X
X

X
X

Selectable

X
X

Zoom
Layered

lx Visible
T Editable
[x Selectable

I"" Zoom Layer

Settings - Layers Rcotdct -

ay— \ I Label... | |Themaiic.T| i ' | Add— | | flcmove |

OK Cancel ]

I PAD_TIET Display Options

Display Mods

|x Sjyle Override

rZoom Layering-

i { F~ Display within 200m range:

Win '

T Show Line Direction
f Shmnfiptlcs
P Show £enlroids

OK Cancel

Line Style

Style:

Color:

Stfdth:

ll

1
| UK

—11*1
•1*]
-1*1
1

-Sample

Cancel ]

Here you can change the style of the objects in the layer (style override)

22



STUK-YTO-TR 102
FINNISH CENTRE FOR RADIATION

AND NUCLEAR SAFETY

PREPARATION OF A MAPINFO WORKSPACE APPENDIX 1

The style of the display can also be changed by creating a thematic map for one field of the table.

- Map > Create Thematic map

ale Thematic Map - Step 1 of 3

Pick a Type of Thematic Map:

Ranges

Gudutttd

B« Charts

DotD*n«?

it
Pi* Chart j

Irtfvtfui1

Cancel j j Bout >

Create Thematic Map - Step 2 of 3

Select a Table and a Fiold:

Iablc: |PAD_TIET [±j

£ield: JQQQSH^HBiUHII^l

P Ignore Zeroes m Blanks

Cancel < flack

Create Thematic Map -Step 3 of 3

Here the objects are coloured or styled according to the value of the selected variable (e.g. the colour
of the road corresponds the road classification)

5. Set the display limits for each layer. This means to set the smallest and the largest zoom level
where the particular map is visible. Vector layers with large number of details and Raster layers
must become visible only when the scale (the zoom) of the map window allows all details being
seen.

- Map > Layer control > Display > Zoom layering

PADJTIET Display Options

• Display Mode-

F Style Override

\

rZoom Layering-

Display within 2.00m range:

Min. zoom: ]3 km

Max. zoom: ji00( km

r Show Line Direction

F Show Nodes

f~ Show Centioids

OK Cancel
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6. Zoom and move the map so that the area of interest is in the middle of the map window.

MapInfo-[PAD TIET.PAD JAR....B214304 Map]
•») File f d i t Objects Queiy Table Oglions Window Map Help

7. When all modifications are made, save the workspace

- File > Save workspace...

Save Workspace

Directories:
c:\map3

CD data

C3 hesa

r~l mb_code

O trados

Qtvk

Drives:

Cancel

|Workspace [M.wor) [±] | m c: elite 510 [±]

24



STUK-YTO-TR 102
FINNISH CENTRE FOR RADIATION

AND NUCLEAR SAFETY

STEP-BY-STEP INSTRUCTIONS OF USING SAHTI SYSTEM

STARTING SAHTI NAVIGATION SYSTEM
APPENDIX 2

The following example assumes that a suitable Maplnfo workspace is prepared earlier. Starting the
system is performed according to the following steps:

1. Check that the GPS PCMCIA card is in the slot and attach the antenna cable to the connector in
the card.

2. Check that Maplnfo's security key is attached to the parallel port of the computer (this is unnec-
essary if you have an unprojected version of Maplnfo).

3. Turn on the computer and make sure that the PCMCIA card is set up properly by automatic
PCMCIA card drivers (a sound signal).

4. Place the antenna on an unobscured surface. Check that there is not many high buildings or trees
covering open sky.

5. Start Windows and program "SAHTI" (program group GPS, for example).

6. A window as follows appears

Options Help

Latitude |

Longitude |

Time ; |No time yet

Start

GPS

Exit

D.On Top,,;;
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7. Check the "Basic Setup" for the following parameters.

- Options > Basic Setup

Map Dir

Mbxfile

Default data filo"

Default fife ID '

Comm. port

Comm. protocol

Plot interval

Default war file

Basic,Setup

•>

COM

f, \MAt>INI O\

SAHHMHX

C\t)SF K\IAF A160?wqs

IAEA

TSIP

10

He default wor file

SUOMI

ilnfo on start

'Correction
'•> Finnish '

O Free ,
O No correction
'Draw made

m Lat

O-Cumulafrve * Single spot <

m

OK Save Cancel

Map directory is the directory, where Maplnfo and the required MapBasic programs are stored.

Suitable plot interval is between 2-10 (the interval of passing data to Maplnfo, approximately in
seconds).
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8. If the system is used for the first time, you must add a new Maplnfo workspace.

- Options > Edit Map list

Edit map list'

SUOMI
VESIVEH

Delete

Q.K

Add new1

Selecting "Add new", shows a standard Windows file open dialogue, through which a prepared
Maplnfo workspace (Extension ".WOR") is added to the system.

Select new.wor file

File name:

C:\MAP3\EXAMPLE.WUR

aino.wot
eesti, woi

gps.woi
hel_vek.wot
iaea.wor
iaea_ht.wor
map pies.woi T

•
Q data
Q hesa
Q mb_code
Q trados
Q t y k T

B e : [ELITE

OK

- I - I '
1-

<
£ancel

9. Click the check box "On Top" to set the SAHTI window to stay always above the map layers.

10. Confirm that you are using Maplnfo to display the position on a digital map.

- Options > Maplnfo

11. Start navigation by clicking the "Start"-button.
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12. If "Use default wor file"-option is not selected from Basic setup window, SAHTI shows a list of
workspaces defined earlier. Select a suitable base map from the list. Maplnfo starts then auto-
matically with the selected workspace.

Select Basemap

ak Cancel

If the default workspace is defined earlier, no list is shown and Maplnfo starts automatically after
clicking "Start"-button.

The co-ordinates should be updated first time at the latest after 5 minutes. If there is no update,
check that GPS is receiving signals from satellites (status on top of the SAHTI window) and make
sure that the antenna is placed properly.

CO-ORDINATE CORRECTION
Once the navigation is working properly, the co-ordinate correction must be set as defined for the
base map. If the correction is not defined yet, it should be performed to obtain higher accuracy
navigation. Section 4.3. explains the principles of co-ordinate correction. Defining the correction is
performed as follows:

1. Set the draw mode to cumulative through GPS menu in Maplnfo

- GPS > Draw mode
r=

Cumulative display is on

I |x [Qn/OH] OK

Click on the check box to change the mode to cumulative.
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2. After about an hour, re-scale the map window so that all measured positions are seen (zoom
tools in main tool box). The centroid of all measurements is estimated and the distance between
the measured centroid and real location on the map is measured using Maplnfo's ruler tool (in
the main tool box). In this example we assume that the distance is 150 m west and 30 m north.

Centroid of measurements

3. Linear correction: Select "Corrections" in GPS menu.

- GPS > Corrections

"1= -Correction^

O Finnish coiteclion

(»F,ee Lon I "
C- None

m Lot

Choose "Free correction". Type 150 in the text box with label Lon and -30 in the text box with the
label Lat. Click OK button.
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4. Method for a Raster image as a base map

A Raster image can be moved into right position by changing the values for Raster Image Registra-
tion in Maplnfo. This is possible if the co-ordinates of control points are expressed in metres, feet
etc. In this example you must subtract 150 from X co-ordinate and add 30 m to Y co-ordinate.

-Table > Raster > Modify Image Registration

Label X Cooid

Image Registration

Y Cooid Eiroi (pixels)

Pt2
Pt3
PM

•2550000.00 • « « » 6800000.00
2550000.00
2560000.00
2560000.00

6790000.00
6000000.00
G790000.0D

Edit...

"::ä:fe:;&' Click- on image'.io modify poinls''coordinates.:Ä::S'!™J;1;f';:i<;

B £ ^ ^ TöHinen \\ \ n 114 3 jj

V ? \ » if ~

#3|sy;;Hew'!

1

/ ,

* :v : i , : .4 ' : i : :v ' | * :

• |

•

0K ^| j j ;S ;̂j:-CariceiW] |; |W|:' [fffl i'|| f ;K U nitsp-ffĵ  | E [fprojectibrug

•••/. Edit Control Point

Edit the information far this control point

Label: jP* 1

Map X: ||25Srj0OO.O0 m

MnpY: 16800000.00 m

image X: |0

Ima.qcY: fÖ~

OK i|};|jS;Canceljff|
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MARK POSITIONS
APPENDIX 2

Locations with special interest (e.g. sampling point) can be marked and co-ordinate information
saved in ASCII file and Maplnfo table. At first the draw mode must be non-cumulative. Marking
and saving goes as follows:

1. Wait that the co-ordinates update while you stay on the interesting spot. Select "Mark" in GPS
menu.

- GPS > Mark positions > Mark

Mark: positions

Longitude

Latitude

Time

Sampling location

Sample ID

Sample type

Team members

Description

(max 200 char.)

Sampling conditions

Temperature

Rel. humidity (%)

pH

Conductivity (mS)

Photograph #

Film#

Analytical request

Mark

Gll.?O!

13.1)1:

S T U K

2

CAR

!»;

:;f)

1S

TIL JKR

Car measurements

+15

Cancel

A dialogue where you can type sample location and other notes appears. Click OK and a red spheri-
cal symbol, referring to the marked location, appears in the map window.

2. Repeat the procedure above as many times as needed.

31



FINNISH CENTRE FOR RADIATION
AND NUCLEAR SAFETY STUK-YTO-TR 102
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3. Save an ASCII file selecting "Save an ASCII file" in GPS menu.

- GPS > Mark positions > Save an ASCII File

Save marked points into a Map Info Table

Ks Rle" flame: JSS|f|S £'SfSiBgv|:g,g||.^fectqries:s

te marked igi;;

estJesUsb
esionia.lab
s es ro ad .S ab

^|Bc: \P
iaea

: Cancel i

: :,:•: '£'>'.i--i $ ]*-••&£'• '•• •'&?£'. s •&••'"<'' • • ? i |

if A; Usl'RIes^of :Type:ls3yiÄBä3
jlJJTable (*.tab) [^ | | ; | | l a c: elite 510 ^lllilliSlllSlli

4. Save a Maplnfo table selecting "Save a Table" in GPS menu.

- GPS > Mark positions > Save a Table

lifgFile Name:
marked

Save marked points into an ASCII file

Directories:
c:\iaea

OK

Cancel

Network...

I I list Files of Type: Drives:

111 Text file (*.M) ic: elite 510

FINISHING THE NAVIGATION:

1. In Maplnfo select "Quit" in GPS menu.

2. Click buttons "Stop" and then "Exit" in SAHTI window.
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PRODUCING MAPINFO MAPS FROM RASTER IMAGES APPENDIX 3
A MAP WITH CO-ORDINATE SYSTEM SUPPORTED BY
MAPINFO
If the co-ordinate system is known and supported by Maplnfo, it easy to fix a Raster image as a
Maplnfo table. A scanned Raster image, a Finnish base map B213406.tif, is used as an example. The
co-ordinate system is the Finnish KKJ system and the co-ordinate units are metres. The control
points are fixed in corners of the image and the co-ordinates are read from the paper map.

First the Raster map is opened in Raster image format.

Open -> Table

File Home:;;::

b21340Btif

r.Open Table*

QiiBCtorias:.

••• c : \ i a e a - v : : ; - :
j ' ; ' : ; ' iilvy-'vp'X^OpBn':;1

< : V Concnl

: Network. ..

Fife Format

JRostBr Image [

; lx Oi s p I ay tab I e i n &j n d ow:

: Drives: ;J;;

c: elite 51D

Image registration window appears. The projection of the map must be selected before fixing the
control points.

The "Finnish co-ordinate systems (ED-50)" is selected as a category and "KKJ2-kaista" is selected
as a category member from "Choose Projection" window.

Choose Projection

Gulagory

jFinnish Coordinate Systems (ED-BO)

Ctitogury Members

KKJ 3-knislu (yhttinnisknordimmtisto)
KK.I 4-knislii

OK Concill

The units are changed to metres from Units window.
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The left upper corner of the image is marked as the first control point. A red cross appears at the
point. In Add Control Point window the co-ordinates are given in Map X (longitude) and Map Y
(latitude) fields. This step is repeated for all four corners of the image. Image registration now
shows the control points and their co-ordinates. The points that are not exactly on a correct line are
shown in the Error column. In that case the points can be adjusted.

Image Registration

L a b e l :•.:•:••::.:-7-..::::;,:•..

';iUL':~;i<-,Click on i
• : ; < . - , j , i . - : . - . . v : . ' i : - - ; - . : • •

»•. " \ Töl

"ftf Äsi K

: x c o o r d ; ; ; > ; :

m
, : < Y C o o r d - E r r o r ( p i x e l s

|\dd Control Point. 1

iW Edit the inform ation for thisiconlrol point : : ^ : ;

: •; T. Mop X : : .

:
;.;?-i:.::-:;Mflp:Y::::;;

• . - • : • - . • ; . . • • • • • • • • • . ' : ; . • : • " . • • : • . • ' ' .

; : " : I1':.;.' . . • . • • • • • ; ; . • • • • • . . • . . - : : • ' • . • : •

;;s;:?älmage>t:?

•.•;;
;f:

:vlmaaeY:iJ

*\_ ^-JMMBi
2 5 5 0 0 0 0 v m - : ; ••::::::; : :" :-

60000D0 :^W]^9::i:[>S\

.i.....;,.:. ., mmm

f
:>':::E(iii-:A:;:l

••••• 1

•?l
i:vjGoto'.;:11

P New!®]

A
A / / \ . '. A

T

• • • ;

OK Cancel Units... Projection...

MapInfo creates a file, where the co-ordinates for the control points of the Raster image are. The file
is an editable ASCII file with extension "tab". The file contains the Raster image name, all the
control points and projection.

Example of file B213406.tab:
!table
!version 300
icharset WindowsLatinl

Definition Table
File "b213406.tif"
Type "RASTER"
(2550000,6800000) (0,0) Label "Pt 1",
(2550000,6790000) (0,5000) Label "Pt 2",
(2560000,6800000) (5000,0) Label "Pt 3",
(2560000,6790000) (5000,5000) Label "Pt 4"
CoordSys Earth Projection 8, 29, "m", 24, 0,
Units "m"

1, 2500000, 0
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PRODUCING MAPINFO MAPS FROM RASTER IMAGES APPENDIX 3
A MAP WHERE THE SCALE AND ORIGIN LONGITUDE
ARE KNOWN, BUT OTHER CO-ORDINATE SYSTEM
PARAMETERS ARE UNKNOWN.

A scanned image of Tallinn, Estonia was produced for use as base map. The origin longitude (25.00
E, vertical longitude line) was found by studying the map. Scale (1:200000) was also given on the
map. An UTM -projection (Universal Transverse Mercator) for central meridian 25.00 E was cre-
ated in MapInfo by editing the file "mapinfow.prj". The following two lines were added into the file:

"- Estonia maps (WGS 84) -"
"UTM ESTONIA-25 (WGS 84)", 8, 104, 7, 25, 0, 0.999995, 500000, 0

The first line is a title, which is displayed when selecting the projection. The second line includes
parameters for a co-ordinate system: 8 is for the projection (Transverse Mercator), 104 is for the
datum (WGS-84, used in GPS), 7 is for the units (metres), 25 is the origin longitude (same as in the
original paper map), 0 is for the origin latitude, 0.999995 is for the scale factor (1—1/200000),
500000 is for the false easting (co-ordinate in meters on longitude 25.00 E) and the final 0 is for the
false northing (co-ordinate in meters on latitude 0.00 N).

One control point was chosen on the map, referring to the location of a hotel car park. Another
control point was measured horizontally 3.5 cm left on the map (equals 7 000 m). The third point
was measured vertically 3.5 cm down on the map (equals 7 000 m). See Figure Al.

Control Points

Figure Al. Scanned image of a map of Tallinn. Three control points are marked with "X" (see text).

35



FINNISH CENTRE FOR RADIATION
AND NUCLEAR SAFETY STUK-YTO-TR 102

APPENDIX 3 PRODUCING MAPINFO MAPS FROM RASTER IMAGES

A GPS was left for over an hour to perform positioning and all the measurements were displayed in
MapInfo. A scanned image, stored as "EESTIBW1.TIF" was opened as Raster Image in MapInfo.
In the Image Registration the projection was chosen (EESTI-UTM25, defined earlier), and the map
units were set for metres. The control points were added according to Figure A1. The co-ordinates of
point 1 were found using Maplnfo's feature for selecting the corresponding control points from the
map on the screen. Points 2 and 3 were calculated by subtracting 7000 m from co-ordinates of
point 1.

ESTJTEST Map
Update Column...

Seococle...
Create Eolnts...
Combine Objects using Column...

Import...
Export...

Maintenance
&<1 ust Imacio Stylos

H/;
l/liol

Select Control Point Irom Map

Image Registration

X Coord Y Coord Eiror (pwol3)

Edit Control Point

Edit the Information tor this control point

Label: [PI I

|1B63IO

Mop Y: 16500720, m

(mogo X: [iEU

The scanned image is opened in MapInfo as a Raster image. The projection is changed into UTM-25
(defined earlier) and the Units are set into metres. The control points which were chosen on the
original map are added with mouse. The control point number 1 refers to the hotel car park. The
plotted GPS measurements show the location of the car park, which makes it possible to select a
control point from the map by clicking mouse when the cursor is in the right place. The co-ordinates
for the control points 2 and 3 are calculated by subtracting 7000 m, respectively (measured from the
original paper map).
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FIXING A MAP WHERE THE SCALE AND CO-ORDINATE
SYSTEM ARE UNKNOWN.

1. A scanned image from Helsinki area is used as a Raster base map. Eleven street corners are
selected as control spots.

2. Positioning is started with the option Single spot display.

3. GPS receiver is moved to the first spot (Pt 1) and SAHTI system is running until the co-ordi-
nates are shown on the map.

4. Mark option is selected from GPS menu in Maplnfo. A dialogue for sample collection appears.
Only Location field is filled. A red symbol on the map shows the location of the GPS receiver.
The receiver is moved to the second position and the procedure is repeated until all the selected
spots are marked.

FIXPOINT Map

Control Points
for selected
street corners

5. Table Fixpoint is saved and the positioning is finished.
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6. For fixing the map, the table Fixpoint is opened again. A scanned image Laippa.bmp is opened
as a Raster image. The projection is selected as Unprojected co-ordinate system.

7. All the control points in Raster image are marked in the Image Registration Window.

After marking all the spots the first control point is selected from the list.

Select Table-> Raster->Select Control Point From Map.

0i] :||£CMÖ^S|;£ I ̂ OK :^I j-̂ CMcaig) I I I I m
8. Move the cursor to the first spot on the Fixpoint map window. Click the symbol and "Add

control point" window appears with the co-ordinates of the spot. Press OK and repeat this with
all the spots.

9. When all the control points are registered, press OK, and the Raster image is shown in the same
map window as Fixpoint table.
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PRODUCING VECTOR MAPS
APPENDIX 4

Maplnfo has tools for digitizing a map from a paper copy. This requires a special digitizing table. If
this is not available, smaller maps can be digitized from Raster maps that already are Maplnfo
tables. Digitizing is performed with Maplnfo drawing tools by fixing the roads and other objects of
interest. This example shows how to digitize roads from a Finnish Raster base map.

1. Open table B213406 and zoom the area so that roads are clearly seen.

2. Select Map-> Layer Control and set Cosmetic Layer editable.

B213406 Map

Layer:

B213406
Cosmetic'Laver

rSeUingsT

Layer Control

Visible Editable Sa

X

j/rLayers—

Add...

'Layered m

I g Cancel 1J:

^Reorder:;

3. Select Options -> Line Style and increase the width of the line to be seen easily.
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4. Select polyline drawing tool from the toolbar and move the cursor to the beginning of the road
you want to digitize. Follow the road and click the mouse in the curves so the line follows the
road.

Lb
&
D
A

O

o
R

5. Double-click in the end of the road to show the digitized object.
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6. When all the wanted objects have been digitized, they are saved as a MapInfo table.

Map->Save Cosmetic Objects..

Cluery Table Options Window
Layer Control...

Change View...
Previous View
View Entire Layer-

Draw Autoiabeis..

Clear Cosmetic Layer

DsgiiKer Setup...
Options...

File Name: £
IdigitesUab

fJirECtones: r J ~ ~ ^ J

| t"] "fen-\ ' [71 [ Cancel

' V V : ' : ' ' l i : " : ^ ' ' * i ' ; : " 1 - - ' •:'-:-"r>>l.'''l':A•1^^;i"?::i.^;'::V;i;:.
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POSITIONING FILE FORMAT

The data file consists of positioning data. All separate fields are in their own line. The first charac-
ters of the line are the line header separated with ":" from the actual data field. If some data fields
are missing, there is no line for that data field. For example if line PC_DATE is missing, the data for
that line was not available. The format is flexible and new variables can be added if required.

The file format is :

I D :
GPS_DATE:
GPS_TIME:
PC_DATE:
PC_TIME:
GPS_DEV:
GPS_MODE:

GPS_HEALTH:
GPS_PDOP:
GPS_SATELLITES:
GPS_SPEED:
GPS_ALT:
LONWGSG:
LATWGSG:
LONWGSD:
LATWGSD:
LONWGSF:
LATWGSF:
LONWGSI:
LATWGSI:
# WGS84
NEXT

- identification for the measurement (GPS(PCMCIA)/ DGPS)
- date of the satellite system
- time of the satellite system
- date of the computer
- time of the computer
- device of positioning (GPS/ DGPS)
- mode of positioning (g,d,f,i)

g = GPS, d = DGPS, f = read from file, i = interpolated
- health information from the satellite
- PDOP parameter
- satellite identification numbers
- speed (km/h)
- altitude (m)
- longitude in WGS84 from GPS
- longitude in WGS84 from GPS
- longitude in WGS84 from Differential GPS
- longitude in WGS84 from Differential GPS
- longitude in WGS84 read from file
- longitude in WGS84 read from file
- interpolated longitude in WGS84
- interpolated longitude in WGS84
- comment line
- beginning of next position data
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Example of the file:

ID:GPS (PCMCIA)
GPS_DATE:96012 6
GPSJTIME:090925:25
PC_DATE:960126
PCJTIME:090925:25
GPS_DEV:GPS
GPS_MODE:g
GPS_HEALTH:0
GPS_PDOP:0.0
GPS_SATELLITES:2 7,16,16,0
GPS_SPEED:4.6
GPS_ALT:33
LONWGSG:25.05337
LATWGSG:60.20868
NEXT
ID:GPS (PCMCIA)
GPS_DATE:96012 6
GPSJTIME:090933:33
PC_DATE:960126
PC_TIME:090933:33
GPS_DEV:GPS
GPS_MODE:g
GPS_HEALTH:0
GPS_PDOP:0.0
GPS_SATELLITES:18,27,16,16
GPS_SPEED:0.0
GPS_ALT:23
LONWGSG:25.05338
LATWGSG:60. 20868
NEXT

APPENDIX 5
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